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INSTRUCTIONS
This symbol is intended to alert the user to the presence of important operating and 
maintenance (servicing) instructions in the literature accompanying the appliance. 
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Chapter 1: Product Overview
About AVWorks
AVWorks is a cross-platform management application that allows you to view 
and control the AutoView 1000R/2000R appliance and all its target devices. The 
cross-platform design ensures compatibility with most popular operating 
systems and hardware platforms. AutoView 1000R provides secure switch-based 
authentication, data transfers and username/password storage. Each appliance 
handles authentication and access control individually, placing system control at 
the point of need. 

AVWorks utilizes browser-like navigation with an intuitive split-screen 
interface, providing you with a single point of access for all your servers. Using 
AVWorks, you can manage your existing appliances, install a new switch or 
launch a video session to a target device. Built-in groupings such as Devices, 
Sites and Folders provide an easy way to select the units to view. Powerful 
search and sort capabilities allow you to easily find any unit. 

NOTE: Throughout the documentation and AVWorks user interface, you will see the word 
“appliance” used generically to describe the AutoView 1000R/2000R switch.

Features and Benefits
Easy to install and configure

AVWorks is designed for easy installation and operation. Auto-discovery of 
managed appliances enables you to deploy new units in minutes. Wizard-
based installation and online help simplify initial system configuration. The 
intuitive graphical interface makes managing and updating appliances simple 
and straightforward.

Powerful customization capabilities

Tailor AVWorks to fit your specific system needs. Take advantage of built-in 
groups or create your own. Customize unit and field names, icons and macros 
for maximum flexibility and convenience. Using names that are meaningful to 
you makes it easy to quickly find any target device.

Extensive AutoView 1000R/2000R management

AVWorks allows you to add and manage multiple appliances in one system. 
Once a new appliance is installed, you can configure switch parameters, 
control and preempt user video sessions and execute numerous control 
functions, such as rebooting and upgrading your appliance. From the intuitive 
Appliance Management Panel, you can enable Simple Network Management 
Protocol (SNMP) traps, configure target devices and cascade switches as well 
as manage user databases.
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Chapter 2: Installation
Getting Started
Before installing your AVWorks, refer to the following lists to ensure that you 
have all the items that shipped with your software as well as all other items 
necessary for proper installation.

Supplied with AVWorks

Your AVWorks package contains the following items:

• AVWorks CD

• AVWorks Installer/User Guide

• Download Instructions

Supported operating systems

AVWorks is supported on the following operating systems:

• Microsoft® Windows® 2000 Workstation - Service Pack 2

• Microsoft Windows 2000 Server - Service Pack 2

• Microsoft Windows NT® 4.0 Workstation - Service Pack 6a 

• Microsoft Windows NT 4.0 Server - Service Pack 6a  

• Microsoft Windows XP (Home and Professional)

• Red Hat Linux® 7.1 (2.7 Kernel)

• Red Hat Linux 7.2 (2.7 Kernel)

PC hardware configuration requirements

The following list contains the PC hardware configuration requirements for 
running AVWorks on the supported operating systems. Configurations with 
less than the recommended requirements are not supported.

• 500 MHz Pentium III 

• 128 MB RAM

• 10 or 100 BaseT NIC 

• XGA Video with graphics accelerator

• Desktop size must be a minimum of 800 x 600

• Color palette must be a minimum of 256 colors

Installing AVWorks 
AVWorks can be installed on Microsoft Windows NT, Windows 2000, 
Windows XP and Linux platforms. Follow these instructions to install 
AVWorks on the desired platform. 
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To install on Microsoft Windows NT, 2000 or XP:

1. Insert the AVWorks CD-ROM into your CD-ROM drive. If AutoPlay is 
supported and enabled, the setup program will start automatically.
-or-
If your system does not support AutoPlay, set the default drive to your 
CD-ROM drive letter and execute the following command to start the 
install program (replace drive with your CD-ROM drive letter):

 drive:\WIN32\SETUP.EXE

2. Follow the on-screen instructions.

To install on Red Hat Linux:

1. Insert the AVWorks CD-ROM into your CD-ROM drive. If AutoPlay is 
supported and enabled, the setup program will start automatically.
-or-
If your system does not support AutoPlay:

a. Mount the CD-ROM volume by executing the following command:
 mount –t iso9660 –ro mode=0555 <unit> <mount point>

 Replace <unit> with the name of the CD-ROM on your machine 
and <mount point> with the name of the desired mount point. For 
example, to mount a CD-ROM which is the second IDE unit on 
/mnt, execute the command:

 mount –t iso9660 –ro mode=0555 /dev/hdb /mnt

b. Execute the following command to change the working directory to 
the mount point:

 cd /mnt

c. Execute the following command to start the install program:
 sh./linux/setup.bin

2. Follow the on-screen instructions.
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Chapter 3: Basic Operations
Launching AVWorks
To launch AVWorks on all Microsoft Windows operating systems:

Select Start - Programs - Avocent AVWorks. 
-or-
Double click the AVWorks icon. AVWorks will launch.

To launch AVWorks on Red Hat Linux (7.1 and 7.2):

From the application folder (/usr/lib/Avocent_AVWorks/), execute the 
following command:
./Avocent_AVWorks
-or-
From (/user/bin), execute the following link:
./Avocent_AVWorks
-or-
If a desktop shortcut was created on installation, double-click the shortcut and 
then select Run. AVWorks will launch.

Navigating AVWorks
AVWorks consists of several components: the AVWorks Explorer, the Video 
Session Viewer (Viewer) and the Appliance Management Panel (AMP). Once 
you launch AVWorks, the main AVWorks Explorer window appears. The 
AVWorks Explorer window allows you to view, access, manage and create 
custom groupings for all of the supported units in your data center. 

When you select a target device, you can click the Connect Video task button in 
the AVWorks Explorer to launch the Viewer. This component allows you to 
control the keyboard, monitor and mouse functions of individual servers. For 
more information, see Accessing and Managing Your Devices in this chapter. 

When you select an appliance, you can click the Manage appliance task button 
in the AVWorks Explorer to launch the AMP. This component enables you to 
configure and control your appliance. For more information, see Chapter 4.

Viewing your system in the AVWorks Explorer

The AVWorks Explorer is divided into several panes: the View Selector tabs, 
the Group Selector pane and the Unit Selector pane. The content of these panes 
will change based on the type of unit selected or the task to be completed. 
Figure 3.1 highlights these navigation features.

Click one of the View Selector tabs to view your system organized by 
categories: Appliances, Devices, Sites or Folders. The AVWorks Explorer’s 
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default display is user-configurable. For more information, see Customizing 
the AVWorks Explorer Window in this chapter. The AVWorks Explorer default 
display is set for the Server view once you have added your first appliance.

NOTE: The Group Selector pane does not appear under the Appliances or Devices tab unless you 
have more than one type of appliance or device.

AVWorks Explorer Window Features

A

B

D

F

G

H

I

E

C

Figure 3.1: AVWorks Explorer Window

A. Menu bar: Allows you to access many of the features in AVWorks.

B. View Selector tab: Contains four View Selector tabs for choosing the AVWorks Explorer view.

C. Root node: Each tree consists of a root node and branches. 

D. Group Selector pane: Contains a tree view representing the groups that are available 
for the current View Selector tab. The selected group controls what is displayed in the Unit 
Selector pane when the Appliances, Devices, Sites or Folder tabs are selected.

E. Status bar: Displays the number of units shown in the Unit list.

F. Unit Selector pane: Contains the Search bar, Unit list and Task buttons appropriate for 
the selected view or group.

G. Search bar: Allows you to search the database for the text entered in the search box. 

H. Unit list: Displays a list of servers, appliances and other selectable devices contained in 
the currently selected group, or the results of the search executed from the Search bar. 

I. Task buttons: Contains buttons representing tasks that can be executed. Some buttons 
are dynamic based on the type of unit(s) selected in the Unit list while other buttons are 
fi xed and always present. 
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Appliance/AVWorks Quick Setup Checklist
The following list is an overview of the steps you will follow to set up and configure 
your AutoView system. Each of these steps is explained in detail in separate topics 
throughout this and the AutoView 1000R/2000R Installer/User Guide.

To set up the AutoView 1000R/2000R: (See the AutoView 1000R/2000R 
Installer/User Guide)

1. Adjust mouse acceleration on each server to Slow or None.

2. Install the AutoView 1000R/2000R hardware, connect the AVRIQ adaptors 
and connect the keyboard, monitor and mouse to the analog port. 

3. Connect a terminal to the confi guration (serial or 101 notation) port on the back 
panel of the AutoView and set up network confi guration (set network speed and 
address type). The IP address can be set from AVWorks. 

4. Using the local analog workstation, input all server names via the On-
Screen Confi guration and Activity Reporting interface (OSCAR).

To set up AVWorks: (See this installer/user guide)

1. Install AVWorks on each AVWorks client. 

2. From one AVWorks client , launch AVWorks. 

3. Click the New Appliance task button to add the new switch to AVWorks 
database. The New Appliance Wizard appears. If you confi gured the IP 
address as described above, select Yes, the product already has an IP 
address, otherwise select No, the product does not have an IP address. 
AVWorks will fi nd the appliance and all AVRIQ adaptors attached to it. 
These names will display in the AVWorks Explorer. 

4. Set properties and group servers as desired into locations, sites or folders 
through the AVWorks Explorer. 

5. Create user accounts through the AMP. 

6. Once one AVWorks client is set up, select File - Database - Save to save a 
copy of the database with all the settings. 

7. From the second AVWorks client, click File - Database - Load and browse 
to fi nd the fi le you have saved. Select the fi le and click Load. 

8. If the local analog workstation (via OSCAR) adds, deletes or renames any 
AVRIQ adaptors after you have loaded this fi le, you can resynchronize 
your local database with OSCAR by clicking the Manage Appliance task 
button and clicking the Resync button under Settings - Devices.

9. To access a server attached to your AutoView 1000R/2000R, select the 
desired server in the AVWorks Explorer and click the Connect Video task 
button to launch a server session in the Video Session Viewer. 

10. Adjust the resolution (select View - Auto Scale) and quality (select Tools - 
Automatic Video Adjust) of the server video in the Video Session Viewer.
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Adding an Appliance
Before you can access your appliance through AVWorks, you must add it to the 
AVWorks database. Once an appliance is added, it appears in the Unit list. You 
may either manually add or discover an appliance. 

To manually add an appliance with an assigned IP address:

1. Select File - New - Appliance from the AVWorks Explorer menu.
-or-
Click the New Appliance task button. The New Appliance Wizard appears. 
Click Next to continue.

2. Select the type of appliance you are adding. Click Next.

3. You are prompted to indicate whether the appliance has an assigned IP 
address or not. Click Yes and then click Next.

4. The Find AutoView 1000R/2000R window appears. Type the IP address 
and click Next. 

Figure 3.2: Find AutoView 1000R/2000R Dialog Box

5. AVWorks will search for the indicated unit as well as all the powered AVRIQs 
and server names you associated with it in OSCAR, if any. If you want to search 
for unpowered AVRIQs, you can access the Resync feature under the Devices 
category in the AMP and click the Include Offl ine AVRIQ adaptors checkbox. 
For more information, see Viewing server connections in Chapter 4. Click Next.
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6. The Confi gure Cascade Switches dialog box appears if AVWorks detects an 
attached legacy switch. This box contains a list of all AVRIQ adaptor EIDs 
(Electronic Identifi cation Numbers) retrieved from the appliance and the 
cascade switches to which they are connected, if any. When this dialog 
box fi rst displays, all the switches will be set to None. Switches detected 
will have an icon next to the pulldown menu.

a. The Existing Cascade Switches fi eld contains all the current switches 
defi ned in the database. Click Add, Delete or Modify to alter the list.

b. Associate the appropriate switch from the pulldown menus for each 
AVRIQ that has a switch attached.

Figure 3.3: Configure Cascade Switches Dialog Box

7. When you reach the fi nal page of the Wizard, click Finish to exit the 
Wizard and return to the main window. Your appliance should now 
appear in the Unit Selector pane.

To manually install a new appliance with no assigned IP address:

1. Select File - New - AutoView 1000R/2000R from the AVWorks Explorer menu.
-or-
Click the New Appliance task button. The New Appliance Wizard appears. 
Click Next to continue.

2. You are prompted to indicate if the AutoView 1000R/2000R has an 
assigned IP address. Click No and then click Next.

3. The Network Address window appears. Type the IP address, subnet mask 
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and gateway that you want to assign to the unit and click Next. 

4. The Select AutoView 1000R/2000R window appears, prompting you to 
select the unit to add from the list of new appliances that were found. 
Select the unit and then click Next.

5. The Confi guring AutoView 1000R/2000R window indicates whether the IP 
information was successfully confi gured. If the confi guration was 
successful, AVWorks will search for the new appliance as well as all 
AVRIQs and server names associated with it. Click Next.

6. The Confi gure Cascade Switches dialog box appears if AVWorks detects an 
attached switch. This box contains a list of all AVRIQ adaptor EIDs 
retrieved from the appliance and the cascade switches to which they are 
connected, if any. 

a. The Existing Cascade Switches fi eld contains a list of all the current 
switches defi ned in the database. You may add, delete or modify the list.

b. Associate the appropriate switch from the pulldown menus for each 
AVRIQ that has a switch attached.

Figure 3.4: Configure Cascade Switches Dialog Box

7. When complete, click Finish to exit the Wizard and return to the main window. 
Your appliance should now appear in the Unit Selector pane.
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To discover an appliance by IP address:

1. Select Tools - Discover from the AVWorks Explorer menu. The Discover 
Wizard appears. Click Next to continue.

2. The Address Range page appears. Type the range of IP addresses to search 
on the network in the To and From boxes. Use the IP address dot notation 
xxx.xxx.xxx.xxx. Click Next to continue.

3. The Searching Network progress bar appears. If one or more new appliances 
are discovered, the Wizard shows the Select Appliances to Add page. From 
this page, you can choose the appliances to add to the local database.
-or-
If no new appliances were found (or if you clicked Stop), the Wizard will 
show the No New Appliances Found page and you will need to add the 
switch manually. For more information, see the previous procedures.

4. Click on an appliance to add and click the Add (>) icon to move the 
selection to the Appliances to Add list.

5. Repeat step 4 for all appliances you wish to add. Click Next to continue.

6. The Adding Appliances progress bar appears while the new switches are 
being added. Once all of the switches have been added to the local 
database, the Discover Wizard Completed page appears. Click Finish to 
exit the Wizard and return to the main window. Your new switch should 
now be in the Unit Selector pane. 

 The Discover Wizard will not automatically fi nd servers attached to the 
appliance. After running the Discover Wizard, you must click the Resync button 
in the Appliance Management Panel to fi nd servers attached to the appliance. 
For more information, see Resynchronizing the server listing in Chapter 4.
-or-
If one or more appliances could not be added to the local database for any 
reason (including if you clicked Stop during the add process), the Discover 
Wizard Not All Appliances Added page appears. This page will list all of 
the appliances that you selected and the status for each. The status will 
indicate if an appliance was added to the local database and if not, why 
the process failed. Click Done when you are fi nished reviewing the list.

NOTE: If an appliance already exists in the database with the same IP address as a discovered 
unit, then the discovered unit will be ignored and will not display on the next Wizard page.

Accessing an Appliance 
When you click the Appliances button, you will see a list of the appliances 
currently defined in the local database. To access an appliance, you must first 
log into it by typing in a username and password. Once you have logged in to 
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an appliance, AVWorks will cache the username and password in memory for 
the duration of the AVWorks session. 

NOTE: You can clear the login credentials by selecting Tools - Clear Login Credentials.

Figure 3.5: Appliance View Tab Selected

To log into an appliance:

1. Click the Appliances button in the AVWorks Explorer.

2. Double-click on an appliance from the Unit Selector pane.
-or-
Select an appliance, and then click the Manage appliance task button.
-or-
Right-click an appliance. A pop-up menu appears. Select Manage appliance.
-or-
Click an appliance in the Unit Selector pane and press Enter. 

3. A password prompt appears. Type in your username and password. The 
default username is Admin with no password.

NOTE: If you previously logged into the appliance during the same AVWorks session, the 
password prompt will not appear.

4. Click OK to access the appliance. This launches the AMP. For more 
information about the AMP, see Chapter 4.
-or-
Click Cancel to exit without logging in.
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Accessing and Managing Your Devices
The Devices tab displays a list of devices defined in the database. The Group 
Selector pane appears if two or more device types are defined. Click All Devices 
or click on a folder to view all devices of a particular type. When you select a 
server and click the Connect Video task button, the Viewer launches. The Viewer 
allows you full keyboard, monitor and mouse control over a server. 

Figure 3.6: Devices View Tab Selected

To access a server:

1. Click the Devices tab in the AVWorks Explorer. 

2. Double-click on the server from the Unit Selector pane. 
-or-
Select a server, and then click the Connect Video task button. 
-or-
Right-click on the server. A pop-up menu appears. Select Connect Video.
-or-
Click a server in the Unit Selector pane and press Enter. The Viewer 
launches in a new window.

To search for a server in the local database:

1. Click the Devices tab and insert your cursor in the Search text box.

2. Type the search information. This can be a device name or property such as 
Type or Location.

3. Click the Search button. The results appear in the Unit list.
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4. Review the results of your search.
-or-
Click the Clear Results button to display the entire list again.

To auto search by typing in the Unit list:

1. Click the Devices tab, then click on any item in the Unit list.

2. Begin typing the fi rst few characters of a device name. The highlight will 
move to the fi rst device name beginning with those characters. To reset 
the search so you can fi nd another device, pause for a few seconds and 
then type the fi rst few characters of the next device.

Interacting with the server being viewed
Once you have connected to a server, the server’s desktop appears in a 
separate window called the Video Session Viewer. You will see both the local 
and the server’s cursor. You may need to align these if they do not move 
together or adjust the video if they seem to jump about. See Aligning the mouse 
or resetting the PS/2 connection in this chapter. 

From this window, you will be able to access all the normal functions of this 
server as if you were sitting in front of it. You may also perform Viewer-
specific tasks such as sending special Macro commands to the server.

Viewer Window Features

A

B

C

E
D

Figure 3.7: Video Viewer Window

A. Menu bar: Access many of the features in the Viewer.

B. Accessed server desktop: Interact with your server through this window.

C. Full Screen Mode button: Expand the accessed server desktop to fi ll the entire screen.

D. Refresh Video button: Regenerate the digitized video image of the server desktop.

E. Align Local Cursor button: Re-establish proper tracking of the local cursor to the 
remote server cursor.
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Expanding and refreshing your Video Viewer
You can adjust your view using the three buttons at the top of the Video Viewer 
window. The first button allows you to align the mouse cursors, the second is 
to refresh the video and the third allows you to expand the Video Viewer 
window to encompass the entire screen. If you choose to expand the Video 
Viewer window, the menu bar will disappear, but you will still see a small 
floating palette with these three buttons and the Macros pulldown menu. 

Figure 3.8: Full Screen Toolbar

To align the mouse cursors:

Click the Align Local Cursor button on the Viewer toolbar. The local cursor 
will align with the cursor on the remote server.

To refresh the screen: 

Click the Refresh Image button on the Viewer toolbar. 
-or-
From the Viewer menu, select View - Refresh. The digitized video image will be 
completely regenerated.

To enter full screen mode:

Click the Full Screen Mode button. 
-or-
From the Viewer menu, select View - Full Screen. The desktop window will 
disappear and only the accessed server desktop will be visible. The screen will 
be resized up to a maximum of 1024 x 768. If the desktop has a higher 
resolution, then a black background will surround the full screen image. The 
floating toolbar will appear.

To exit full screen mode:

Click the Full Screen Mode button on the floating toolbar to exit full screen 
mode and return to the desktop window.

Adjusting the Video Viewer window
You can adjust both the resolution and quality of the Video Viewer. You can also 
expand your session to fit the entire screen or refresh the view at any time. 
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Adjusting the window size

The Video Viewer allows you to set up automatic or manual scaling of the 
session image. When Auto Scale is selected, the desktop window remains fixed 
and the server image is scaled to fit the window. When Manual Scale is selected, 
a drop-down menu of supported image scaling resolutions is displayed. 

To adjust the size of the Video Viewer window:

From the menu, select View - Auto Scale to allow the server image to be 
scaled automatically.
-or-
From the menu, select View - Manual Scale, then choose the dimension to 
scale the window.

Figure 3.9: Viewer Manual Scale

Adjusting the video quality

The Video Viewer offers both automatic and manual video adjustment 
capability. Generally, the Automatic Video Adjustment will optimize the video 
for the best possible view. However, you may fine tune the video with the aid 
of Avocent technical support. See Appendix D: Troubleshooting. Video 
adjustment is a global setting and applies to each target device you access. 

Adjusting mouse settings
The Video Viewer allows you to select among five different mouse cursor 
options, set up mouse scaling and resynchronize your mouse should it no 
longer track properly. Mouse settings are target device-specific and can be set 
differently for each. These setting are placed into the local client database and 
applied each time you launch a session to a specific device. 
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Figure 3.10: Viewer Mouse Session Options Dialog Box

Setting mouse scaling

You can choose among three preconfigured mouse scaling options or set your 
own custom scaling. The preconfigured settings are: Default (1:1), High (2:1) 
or Low (1:2). In a 1:1 scaling ratio, every mouse movement on the desktop 
window will send an equivalent mouse movement to the server. In a 2:1 
scaling, the same mouse movement will send a 2X mouse movement. In a 1:2 
scaling, the value will be 1/2X. 

To set custom mouse scaling:

1. Select Tools - Session Options. The Session Options dialog box appears.

2. Click the Mouse tab.

3. Click the Custom radio button. The X and Y fi elds become enabled.

4. Type a mouse scaling value in the X and Y fi elds. For every mouse input, 
the mouse movements are multiplied by the respective X and Y scaling 
factors. Valid input ranges are 0.25 to 3.00.

Aligning the mouse or resetting the PS/2 connection

If you find that your mouse or keyboard no longer responds properly, you can align 
the mouse to re-establish proper tracking or reset the PS/2 connection. Resetting 
the PS/2 causes the appliance to simulate a mouse and keyboard reconnect at the 
server as if you had disconnected and then reconnected them. Alignment causes 
the local cursor to be aligned with the cursor on the remote server.

NOTE: If the server does not support the ability to disconnect and reconnect the mouse (almost 
all newer PCs do), then the mouse will become disabled and the server will have to be rebooted.
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To realign the mouse:

Click the Align Local Cursor button on the Viewer toolbar.

To reset the PS/2 connection:

1. Select Tools - Session Options in the Viewer. The Session Options dialog 
box appears.

2. Click the Mouse tab.

3. Click the Reset PS/2 button. A dialog box appears prompting you to confi rm. 

4. Click the Reset PS/2 Connection at the Device checkbox and click OK.

Using macros to send keystrokes to a device 
The Macros menu in the Video Viewer allows you an easy way to send 
multiple keystrokes to the server or to send keystrokes that you cannot 
generate without affecting your local system, such as Control-Alt-Delete. The 
Viewer provides a list of default keystroke selections; however, you may set up 
your own macros, as well as change the set that displays by default, by 
selecting the Configure option at the bottom of the Macros pulldown menu. 

Figure 3.11: Viewer Macro Menu Expanded

Sending keystrokes to a device

Select the Macros menu in the Viewer and choose the macro to send to the 
server. Figure 3.11 shows the default macros that ship with AVWorks. If you do 
not see the keystroke you need, select Configure to access the Macros dialog 
box. Here you can create, modify, delete and group macros. 
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Macro Groups settings are specific to each target device and, therefore, can be 
set differently for each device. These setting are placed into the local client 
database and applied each time you launch a session to a specific device. 

To change the default Macro group:

1. Select Tools - Session Options in the Viewer. The Session Options dialog 
box appears.

2. Click the Macros tab.

Figure 3.12: Viewer Session Options Dialog Box - Macro Tab

3. Select a macro group from the pulldown list to appear in the Macro menu 
and click OK.

Creating new macros

You can create custom macro keystrokes as well as modify and delete existing 
macros through the Macros dialog box.

To create a new macro:

1. Select Macros - Confi gure from the Viewer. The Macros dialog box appears.
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Figure 3.13: Viewer Macro Dialog Box

2. Click Create. The Create/Edit Macros dialog box appears.

Figure 3.14: Viewer Create/Edit Macro Dialog Box
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3. Type the name of the macro in the Macro Name fi eld.

4. Select the desired category and keystrokes from the list of Available 
Keystrokes and click Add.
-or-
Type the keystrokes to send in the Keystrokes fi eld.

5. Click OK to accept the macro and return to the Macros dialog box.
-or-
Click Reset to erase all the keystrokes entered in the Keystrokes fi eld.

Grouping macros

The Macro Groups dialog box allows you to arrange macros into logical 
groups. Macro groups for Windows and Sun are already predefined; you can 
alter either of these two groups or create an entirely new group. You can also 
rename and delete groups that have been previously created.

To create a macro group:

1. Select Macros - Confi gure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears. The Macros Available 
box contains macros that are not currently in use by this group.

Figure 3.15: Viewer Macro Groups Dialog Box
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3. Click Create. A dialog box appears prompting you to name the new macro group. 

4. Type in a name. Click OK to save the name and return to the Macro 
Groups dialog box. A tab with the new name appears.

To add macros to an existing group:

1. Select Macros - Confi gure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears.

3. Click the macro group tab to alter. Windows and Sun are the default tabs. 
If you have created a new group, you will see a tab for this group as well. 

4. Click on the macro to add from the Macros Available pane on the left side 
of the dialog box. Click the Add button. The macro appears in the Macros 
in Group box. Use the Move Up and Move Down buttons to move the 
macro up or down in relation to the other macros.

5. Repeat step 4 until all the macros to be grouped appear in the Macros In 
Group box.

6. Click OK to accept the macro group and return to the Macros dialog box.
-or-
Click Cancel to leave this dialog box without saving changes.

To remove macros from an existing group:

1. Select Macros - Confi gure from the Viewer. The Macros dialog box appears.

2. Click Group. The Macro Groups dialog box appears.

3. Click the macro group tab to alter. Windows and Sun are the default tabs. 
If you have created a new group, you will see a tab for this group as well. 

4. Click on the macro to remove from the Macros in Group pane on the right 
side of the dialog box. Click the Remove button. The macro appears in the 
Macros Available box. 

5. Repeat step 4 until all the macros to be removed appear in the Macros 
Available box.

6. Click OK to accept the macro group and return to the Macros dialog box.
-or-
Click Cancel to leave this dialog box without saving changes.

Changing AVWorks Device Properties
You can alter device properties from the AVWorks Explorer Properties dialog 
box including General, Network, Information and Connections. The General 
tab allows you to change the device name, device type and the icon that will be 
used to display the server in AVWorks. You may also assign the server to a site, 
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location or folder. The Network tab lets you set a browser URL for that server if you 
want to view it in a browser window instead of through a session Viewer. The 
Information tab allows you to enter information about the server including a server 
description, contact information and any comments you would like to add. Lastly, 
the Connections tab displays the connection that will be used for a specific server. 

NOTE: You can also change the properties of your appliance. For more information, see Chapter 4.

To change device properties:

1. Select an individual server in the Unit Selector list.

2. Select View - Properties from the AVWorks Explorer menu.
-or-
Click the Properties task button. The Properties dialog box appears.

Figure 3.16: Server General Properties Tab

3. Type in the name of the server. A warning will display if you enter a 
duplicate name. 

4. (Optional) Select the device type. If the selection is not in the pulldown, 
type the name of the new server type in the text fi eld. Once entered, the 
option becomes available in the pulldown for future assignment.

5. (Optional) Select the icon to display for the unit.

6. (Optional) Assign a server to a site, department or location. (These 
categories are customizable. See Modifying custom fi eld names in this 
chapter.) If an option is not in the pulldown, type the name of the new 
assignment in the text fi eld. Once entered, the option becomes available in 
the pulldown for future assignment.
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7. (Optional) Click the Network tab and type in the URL to use when 
establishing a browser connection to the server. If the fi eld contains a 
value, then the Browser button appears in the task bar allowing you to 
launch the browser to that specifi ed URL.

Figure 3.17: Server Network Properties Tab

8. (Optional) Click the Information tab and type in a description of the unit. 
There are no rules for the type of information that you may enter here. 

Figure 3.18: Server Information Tab

9. (Optional) Click the Connections tab to view the physical connection path that 
will be used to access this device. This feature is useful for troubleshooting. 
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Figure 3.19 shows a connection to a server. Figure 3.20 shows a server 
connected to Channel 1 of a legacy switch.

   

Figure 3.19: Server Connection Example   

10. When fi nished, click OK to save the new settings.
  -or-
  Click Cancel to exit without saving the new settings.

Accessing a server via a browser window
You can configure your system to open a server connection in a browser 
window. You must first select a server and define a URL in the Properties dialog 
box. Then, when you select the server, the Browse task button appears. You can 
select the browser to use in the AVWorks Explorer’s Options dialog box. 

To launch the server URL in a browser window: 

1. Select a server in the Unit Selector pane. 

2. If you have defi ned a URL for this server in the Properties dialog box, the 
Browse task button appears. Click the Browse task button. The URL you 
identifi ed will launch in a browser window.

Organizing Units with the Local Client Database
The local client database provides persistent storage for unit names, 
properties, network addresses and custom session settings. Device attributes 
such as type, site and department allow you to create and store logical groups 
for your devices. Custom folders allow you to group units within the local 

Figure 3.20: Switch Connection Example
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client database. View tabs, sort bars and search functions use these attributes 
to find specific units within the database. 

Site organization is based on where your servers are located and refers to the 
column headings Site and Department, which can be customized to suit your 
needs. See Modifying custom field names in this chapter. Folders provide a way to 
create a customized organizational system for individual servers. For example, 
you might want to create a folder for critical servers or for remote servers. 

You may change the order and sorting of the Unit Selector list by clicking the 
sort bar above the column. An upward-pointing arrow in a column header 
indicates that the list is sorted by that field name in ascending order. A 
downward-pointing arrow indicates the list is sorted by that field name in 
descending order.

The sort bar properties are customizable. Figures 3.21 and 3.22 show examples 
of how you might use the default field name values. You may change them to fit 
your own organization. Figure 3.23 features customized field names.

Figure 3.21: Sites View Tab Selected
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Figure 3.22: Folders View Tab Selected

Modifying custom field names
Custom field names allow you to change the Site, Department and Location 
column heading names that appear in the Group and Unit Selector panes. This 
allows you to group appliances and servers in ways that are meaningful to 
you. The Department field is a subset of Site. If you customize these field 
names, you should keep this hierarchy in mind. 

Figure 3.23: Example of Modified Custom Fields

To modify a custom fi eld label:

1. Select Tools - Options from the AVWorks Explorer menu. The Options 
dialog box appears. 
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Figure 3.24: Options Dialog Box - Custom Field Labels

2. Select a fi eld label to modify and click the Modify button. The Modify 
Custom Field Label dialog box appears.

3. Type the singular and plural versions of the fi eld label. The length can be 
from 1 to 32 characters. A blank value is not allowed. Spaces are permitted 
in the middle but leading and trailing spaces are not allowed. 

4. Click OK to save the new fi eld label.
-or-
Click Cancel to exit without saving changes.

Creating new sites, departments, locations or folders
You can organize units within your local database into sites, departments 
locations or folders by assigning a unit to that structure. Sites, departments and 
locations all appear under the Sites tab. These default headings can be 
changed. See Modifying custom field names in this chapter. Folders appear 
under the Folders tab and provide as many organizational options as you can 
imagine folder names. 

To create a new site, department or location:

1. Select View - Properties from the AVWorks Explorer menu. 
-or-
Click the Properties task button. The Properties dialog box appears.
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2. Click the General tab and select the pulldown menu for Site, Department or 
Location. If a name is not in the pulldown menu, type the name you want in 
the text fi eld. The name can be from 1 to 32 characters long. Names are not 
case sensitive and can consist of any combination of characters entered 
from the keyboard. Spaces are permitted in the middle but leading and 
trailing spaces are not allowed. Duplicate names are not allowed. 

3. Click OK. The new site, department or location appears in the Group 
Selector pane.

To create a new folder:

1. Select the Folders View tab. 

2. Click on the top-level Folders node and select File - New - Folder. 
-or-
Right-click on the Folders node and select New Folder. The New Folder 
dialog box appears.
-or
Click on an existing folder and select File - New - Folder to create a nested folder.

NOTE: You may also create nested folders. Click on an existing folder to create a nested folder.

3. Type in a name for the folder from 1 to 32 characters long. Folder names 
are not case sensitive and can consist of any combination of characters 
entered from the keyboard. Spaces are permitted in the middle but leading 
and trailing spaces are not allowed. Duplicate folder names are not 
allowed at the same level but are allowed across different levels. 

4. Click OK. The new folder appears in the Group Selector pane.

Assigning a unit to a site, location or folder
Once you have created a new site, location or folder, you can assign an 
appliance or server to that organization. The Assign menu item is only enabled 
when a single appliance or server is selected in the Unit Selector pane. These 
custom targets are defined in the General Properties dialog box. 

To assign a unit to a site, location or folder: 

1. Select a unit in the Unit Selector pane. 

2. Select Edit - Assign from the AVWorks Explorer menu.
-or-
Click the Assign To task button. 
-or
Right-click on a unit and select Assign To. The Assign To dialog box appears.
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Figure 3.25: Assign To Dialog Box

3. Select the site, location or folder category from the pulldown menu. 

4. Select the target from the list of available targets to which the unit can be 
assigned within the chosen category. This could be empty if no site, 
location or folder has been defi ned in the local database.

5. Click OK to save the assignment.
-or-
Click Cancel to exit without saving changes.

To drag and drop a unit into a site, location or folder:

Click and hold on a unit in the Unit list. Drag the item on top of a folder icon 
(node) in the tree view of the Group Selector pane. Release the mouse button. 
The item now appears in the Unit list when you click that node. 

NOTE: A unit cannot be moved to All Departments, All Units or the root Sites node. Units can 
only be moved one at a time.

Deleting and Renaming 
The delete function works based on what is currently selected in the Group and 
Unit Selector panes. When you select and delete a unit in the Unit list, the unit is 
removed from the local database. This will not affect the configurations in OSCAR. 
When you select and delete an item in the tree view of the Group Selector pane, 
you will delete Server Types, Sites, Departments or Folders; however, none of the 
actions result in units being deleted from the local database. 

The rename function is also dependant on what is currently selected. You can 
select and rename an appliance or a server from the Unit list. You can select 
and rename server types, sites, departments and folder names in the tree view 
of the Group Selector pane.

NOTE: If you delete or rename a server through AVWorks, the OSCAR server list at the local 
analog workstation becomes out of date. Resynching will not download server names into OSCAR. 
Devices should be deleted or renamed from OSCAR and then resynchronized in AVWorks.
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To delete an appliance or server:

1. Select the unit(s) to delete from the Unit Selector pane.

2. Select Edit - Delete.
-or-
Press the Delete key on your keyboard. A dialog box appears confi rming 
the number of units to be deleted. If you are deleting an appliance, the 
dialog box includes a Delete Associated Devices checkbox. Enable/disable 
the checkbox as desired.

3. Click Yes to confi rm the deletion. Additional message prompts may appear 
depending on your confi guration. Respond as appropriate. The appliance 
or server is deleted.
-or-
Click No to cancel.

To delete a device type, site, department or folder:

1. Select the device type, site, department or folder to delete from the Group 
Selector pane.

2. Select Edit - Delete.
-or-
Press the Delete key on your keyboard. A dialog box appears confi rming 
the number of units that will be affected by this deletion. 

3. Click Yes to confi rm the deletion. Additional message prompts may 
appear depending on your confi guration. Respond as appropriate. The 
element is deleted.
-or-
Click No to cancel.

To rename a device type, site, department or folder:

1. In the Group Selector pane, click on the device type, site, department or 
folder to rename.

2. Select Edit - Rename. The Rename dialog box appears.

3. Type in a name from 1 to 32 characters long. Names can consist of any 
combination of characters entered from the keyboard. Spaces are 
permitted in the middle but leading and trailing spaces are not allowed. 
Duplicate names are not allowed, including the same name with different 
cases, with two exceptions: department names can be duplicated across 
different sites and folder names can be duplicated across different levels.

4. Click OK to save the new name.
-or-
Click Cancel to exit without saving changes.
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Customizing the AVWorks Explorer Window
The AVWorks Explorer window can be resized at any time. Each time you 
launch the application, the AVWorks Explorer window opens to its default size 
and location. 

A split-pane divider that runs from top to bottom separates the Group Selector 
pane and the Unit Selector pane. You can move the divider left and right to 
change the viewing area of the Group Selector pane and the Unit Selector 
pane. Each time AVWorks Explorer is started, the divider will appear in its 
default location. See Appendix B for divider pane and tree view control mouse 
and keyboard shortcuts.

Modifying the selected view on startup
When Default is checked under the selected view on the startup option, the 
AVWorks Explorer will determine which view to display. If you have one or 
more servers defined, the Devices display will appear by default. If you do not, 
the Appliances display will appear. 

When Default is unchecked, the AVWorks Explorer will display the view 
selected in the pulldown menu shown below the checkbox. The pulldown 
menu contains the following values: Appliances, Devices, Sites and Folders. 
The pulldown menu is only enabled when the checkbox is unchecked.

To modify the selected view on startup:

1. Select Tools - Options from the AVWorks Explorer menu. The Options 
dialog box appears. 

2. Select Appliances, Devices, Sites or Folders from the pulldown menu.

3. Click OK to save the new startup view.
-or-
Click Cancel to exit without saving changes.

Changing the default browser
You can specify which browser launches when viewing a server URL in a 
browser window. You have the option of using the default browser for your 
system, or you can select a specific browser to launch for that server. 

To change the default browser:

1. Select Tools - Options from AVWorks Explorer. The Options dialog box appears. 

2. Deselect the Launch Default Browser checkbox. The Browse button is enabled.

3. Click the Browse button and navigate to the browser.
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4. Click OK to save the new browser selection.
-or-
Click Cancel to exit without saving changes.

Managing Your Local Databases
Each workstation running AVWorks contains a local database that records the 
information that you enter about your units. If you have multiple workstations, 
you may configure one station and then save a copy of this database and load it 
into the other stations to avoid unnecessarily reconfiguring each station. You 
may also export the database for use in another application. 

Saving a database
AVWorks allows you to save a copy of the local database for later use. The 
saved database can then be loaded back to the same computer where it was 
created, or it can be loaded onto another AVWorks client. The saved database 
is compressed into a single Zip file. 

While the database is being saved, no other activity is allowed. All other 
windows including Video Session windows and Appliance Management Panel 
windows must be closed. If other windows are open, a message will appear 
prompting you to either continue and close all open windows or quit and 
cancel the database save process. 

To save a database:

1. Select File - Database - Save. The Database Save dialog box appears. 

Figure 3.26: Database Save Dialog Box

2. Type in a fi le name and choose a location to save the fi le.

3. Click Save. A progress bar appears during the save. When fi nished, a 
message appears indicating that the save was successful and you are 
returned to the main window.
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Exporting a database
This function allows you to export fields from the local database to an ASCII 
Comma Separated Value file (CSV) or Tab Separated Value file (TSV). The 
following database fields will be exported. 

Exported Database Fields 

AutoView 1000R/2000R Flag
Type
Name
Address 
Custom Field 1
Custom Field 2
Custom Field 3
Description
Contact Name
Contact Phone #
Comments
Browser URL

NOTE: The Address fi eld only applies to appliances and the Browser URL fi eld only applies to 
servers. In the exported fi le, the Address fi eld data will be empty for servers and the Browser 
URL fi eld data will be empty for appliances.

The first line of the exported file contains the column names for the field data. 
Each additional line contains the field data for an appliance or server. The file 
will contain one line for each appliance and server defined in the local database. 

To export a database:

1. Select File - Database - Export from the AVWorks Explorer menu. The 
Database Export dialog box appears.

2. Select a database to export. 

3. Type in a fi le name and browse to the location to save the exported fi le.

4. Click Export. A progress bar appears during the export. When fi nished, a 
message appears indicating that the export was successful and you are 
returned to the main window.

Loading a database
This function allows you to load a database that was previously saved. While the 
database is being loaded, no other activity is allowed. All other windows including 
Video Session windows and Appliance Management Panel windows must be 
closed. If other windows are open, a message appears prompting you to either 
continue and close all open windows or quit and cancel the database save process. 
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To load a database:

1. Select File - Database - Load from the AVWorks Explorer menu. The 
Database Load dialog box appears. 

2. Browse to select a database to load. 

3. Click Load. A progress bar appears during the load. When fi nished, a 
message appears indicating that the load was successful and you are 
returned to the main window.
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Chapter 4: Managing Your Appliance
Once you have installed a new appliance, you have the ability to view and 
configure unit parameters, view and control currently active video sessions 
and execute a variety of control functions such as rebooting and upgrading 
your appliance. This is accomplished through the Appliance Management 
Panel (AMP). The AMP has three tabbed panels: Settings, Status and Tools.

Figure 4.1: Appliance Management Panel Dialog Box

To access the AMP:

1. Click the Appliances button in the AVWorks Explorer.

2. Double-click on an appliance from the Unit Selector pane.
-or-
Select an appliance from the Unit Selector pane, then click the Manage 
appliance task button.
-or-
Right-click on an appliance in the Unit Selector pane. A pop-up menu 
appears. Select Manage appliance.
-or-
Click an appliance in the Unit Selector pane and press Enter. 

3. A password prompt appears. Type in your username and password and 
click OK. The default username is Admin with no password.

NOTE: AVWorks caches your user credentials until the application is closed. You do not need 
to re-enter your credentials for each session.

4. The Appliance Management Panel dialog box appears.
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Viewing and Configuring Appliance Parameters
The Settings tab allows you to display an expandable list of categories covering 
a wide range of parameters for your appliance. When a category is selected 
from the list, the parameters associated with the category will first be read 
from the unit, the local database or both. You will then be able to modify those 
parameters and send the changes securely back to the appliance.

Changing global network and session parameters
The Global category allows you to view the product type, part and serial number 
and language setting for the appliance. If you select the Network sub-category, 
you will be able to change the network settings including the IP address, subnet 
mask, gateway, LAN speed and BootP setting. If you select the Sessions sub-
category, you can enable the session time-out to allow the appliance to close an 
inactive video session after a specified number of minutes.

Setting up user accounts
When you select the Users category for the first time, the AMP will retrieve and 
display a list of usernames and current access levels from the appliance. You 
can add, modify or delete users in this listing. You can assign three access 
levels: User, Administrator and Appliance Administrator. The User Access 
level allows you to assign individual server access rights to a user. 

User Access Level Rights

Operations MA Admin User Admin User

Preemption All Equal and lesser Equal and Lesser

Confi gure network & global settings 
(security mode, time-out, SNMP) Yes No No

Reboot Yes No No

FLASH upgrade Yes No No

Administer user accounts Yes Yes No

Confi gure port settings Yes Yes No

Monitor server status Yes Yes No

Break Yes Yes Yes

Target Device Access Yes Yes Assigned by Admin
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Figure 4.2: Users Dialog Box

To add or modify a user:

1. Click the Users category in the left column in the AMP.

2. Click the Add button on the right side of the window to add a new user. 
The Add User dialog box appears.
-or- 
Select a user and click the Modify button to modify a current user. The 
Modify User dialog box appears.

Figure 4.3: Add User Dialog Box

3. Enter the username and password to assign to the user and then verify the 
password by typing it into the Verify Password fi eld.

4. Select the appropriate access level for this user from the pulldown menu. 
If you select the User option, the Access Rights button appears. 

a. Click the Access Rights button to select individual servers for that 
user. The User Access Rights dialog box appears.
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Figure 4.4: User Access Rights Dialog Box

b. Select a server in the left column for which this user should have 
access rights. Select the Add button.

c. Select a server in the right column from which to remove a user’s 
access rights. Click the Remove button.

d. Repeat steps a and b until the right column represents the appropri-
ate server access for this user, and then click OK.

5. Click OK to save the settings and return to the main AMP window.

To delete a user:

1. Click the Users category in the left column in the AMP and then select the 
user(s) to delete.

2. Click the Delete button on the right side of the AMP Users window. A 
confi rmation window appears. 

3. Click Yes to confi rm the deletion.
-or-
Click No to exit the window without deleting the user.

Viewing the AVRIQ adaptors 
The AVRIQs category lets you view the AVRIQ adaptors in your system, their port 
and EID numbers as well as the computer type and keyboard language. You can 
also view the AVRIQ status. A green circle indicates that the AVRIQ is online. A 
yellow circle means the AVRIQ is being upgraded and a red X indicates that the 
AVRIQ is offline.

Enabling and configuring SNMP 
SNMP (Simple Network Management Protocol) is a protocol used to communicate 
management information between network management applications and 
appliances. Other SNMP managers (such as Tivoli and HP OpenView) can 
communicate with your appliance by accessing MIB-II (Management Information 
Base) and the public portion of the enterprise MIB. MIB-II is a standard MIB that 
many SNMP servers support. When you select the SNMP category for the first 
time, the AMP will retrieve the SNMP parameters from the unit. 
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In this dialog box, you can enter system information and community strings. 
You may also designate which stations can manage the appliance as well as 
receive SNMP traps from the switch. For more information on traps, see 
Enabling individual SNMP traps in this chapter. If you check Enable SNMP, the 
unit will respond to SNMP requests over UDP (User Datagram Protocol) port 
161. Port 161 is the standard UDP port used to send and receive SNMP messages.

If you enter one or more allowable managers, only those IP addresses will be 
able to manage the appliance via SNMP. If you do not enter any allowable 
managers, then the appliance can be managed via SNMP from any IP address.

NOTE: The AMP uses SNMP within a secure tunnel to manage appliances. For this reason, 
UDP Port 161 need not be exposed on fi rewalls. You will need to expose UDP Port 161 to 
monitor Avocent appliance via third-party SNMP-based management software.

Figure 4.5: SNMP Configuration Dialog Box

To confi gure general SNMP settings:

1. Click the SNMP category in the left column in the AMP.

2. Click the Enable SNMP checkbox to allow the appliance to respond to 
SNMP requests over UDP port 161. 

3. Enter the system’s fully qualifi ed domain name in the Name fi eld, as well 
as a description and node contact person in the System section.

4. Enter the Read, Write and Trap community names. These specify the 
community strings that must be used in SNMP actions. The Read and 
Write strings only apply to SNMP over UPD port 161 and act as passwords 
that protect access to the appliance. The values can be up to 64 characters 
in length.

Download from Www.Somanuals.com. All Manuals Search And Download.



50 AVWorks Installer/User Guide

5. Add up to four SNMP management entities to monitor this appliance or leave 
this blank to allow any station to monitor the appliance.

a. Click the Add button to defi ne an allowable manager. The Allowable 
Manager dialog box appears.

b. Type in the IP address of the management station to add.
c. Click OK to add a management station.

6. Add up to four SNMP trap destinations to which this appliance will send 
traps in the Trap Destination fi eld.

a. Click the Add button to defi ne a trap destination. The Trap Destina-
tion dialog box appears.

b. Type in the IP address of the trap destination to add.
c. Click OK to add a trap destination.

7. Click OK to save the settings and close the window.
-or-
Click Apply to save the settings and remain in the open window.
-or-
Click Cancel to exit the window without saving.

Enabling individual SNMP traps
An SNMP trap is a notification sent by the appliance to a management station 
indicating that an event has occurred in the appliance that may require further 
attention. You can specify what SNMP traps are sent to the management 
stations by simply clicking the appropriate checkboxes in the list. When you 
select the Traps category for the first time, the AMP will retrieve and display a 
list of SNMP traps from the appliance. You may select Enable All or Disable All 
to easily select or deselect the entire list.

Figure 4.6: Traps Dialog Box
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Viewing server connections
When you select the Devices category for the first time, the AMP will retrieve 
the servers that exist in the AVWorks database as well as information on how 
the servers are connected to the selected appliance. 

The Connection column displays the current server connection. This can be to 
either an AVRIQ adaptor or a cascade switch. If connected to an AVRIQ adaptor, 
the AVRIQ’s EID will display in the Connection column. If connected to a 
cascade switch, the switch and all of its channels will be displayed. If no unit is 
currently connected to the path, then this field will display as None. If you click 
either an AVRIQ or switch in the Connection column, the Viewer will launch. 

Figure 4.7: Devices Dialog Box

Resynchronizing the server listing
You may choose to periodically resynchronize the database on your AVWorks client 
with the database stored in the appliance. Do this if the local analog workstation has 
changed server names or if AVRIQ adaptors have been added or moved.

NOTE: This procedure only resynchronizes your own AVWorks client. If you have multiple 
AVWorks clients, save your resynchronized local database and load it into the other AVWorks 
client to ensure consistency.

To resynchronize the server listing:

1.  Click the Resync button in the Server category of the AMP. The Resync 
Wizard launches. Click Next.

2. A warning message displays indicating that the database will be updated 
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to match the current confi guration in the appliance. Your current local 
database names will be overridden with the appliance names. Click Next.

3. A polling appliance message box appears with a progress bar indicating 
that the appliance information is being retrieved.

4. If no changes were detected in the appliance, a completion dialog box 
appears with this information. Click Finish to exit.
-or-
If changes were detected in the appliance, the Detected Changes dialog 
box appears. Click Next. 

a. If a cascade switch was detected, the Enter Cascade Switch Informa-
tion dialog box appears. Select the type of switch connected to the 
appliance from the pulldown menu. If the type you are looking for is 
not available, you can add it via the Add button. For more informa-
tion, see Confi guring cascade switch connections in this chapter.

 -or-
If no cascade switch was detected, then the Detected Changes dialog 
box will be displayed. 

b. Click Next to update the database.
c. When the update is fi nished, a completion dialog box appears. Click 

Finish to exit.

Configuring cascade switches connections
The Cascade Switches category lets you view the cascade switches in your system 
the AVRIQ adaptor EID numbers as well as the type of switch and the port to 
which it is connected.

To confi gure a cascade switch connection:

1. Click the Cascade Switches category in the left hand column in the AMP.

2. Click the pulldown list next to the switch and select the switch type to assign.
-or-
If the switch type isn’t in the pulldown list, add a switch to the Existing 
Cascade Switches list by clicking the Add button.

a. The Add Cascade Switch dialog box appears. Type the name of the 
switch and select the switch type from the list.

b. Click OK to add the switch. The switch should now be in the Existing 
Switches list and in the Switch pulldown list.

3. Repeat step 2 for each switch that you wish to confi gure.

4. When fi nished, click OK to save the new settings.
-or-
Click Cancel to exit without saving.
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Figure 4.8: Configure Cascade Switches Dialog Box

Upgrading Firmware
You can upgrade the firmware for either the appliance or the AVRIQ adaptors. 
The AVRIQ adaptors can be upgraded individually or simultaneously. When 
an upgrade is initiated, you will see a message indicating the current status. As 
long as an upgrade is in progress, you cannot initiate another.

Viewing appliance Version information
When you select the Version category for the first time, the AMP will retrieve the 
firmware versions from the selected appliance. The Hardware sub-category 
displays the version information for the unit itself. The AVRIQs sub-category 
allows you to view and upgrade all of the AVRIQ adaptors in the system. 

Download from Www.Somanuals.com. All Manuals Search And Download.



54 AVWorks Installer/User Guide

Figure 4.9: Firmware Version Dialog Box

To upgrade appliance fi rmware:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Upgrade AutoView 1000R/2000R Firmware button. The 
Firmware Upgrade dialog box appears. Type in the TFTP (Trivial File 
Transfer Protocol) server IP address where the fi rmware is located as well 
as the fi rmware fi lename and directory location.

Figure 4.10: Upgrade Firmware Dialog Box

3. Click the Upgrade button. The Upgrade button dims and a progress 
message appears.

4. When the upgrade is complete, a message appears, prompting you to confi rm 
a reboot. The new fi rmware will not be used until the switch reboots. Click 
Yes to reboot the appliance. The Upgrade Firmware dialog box will display a 
progress message including a message that the reboot is complete. 
-or-
Click No to reboot at a later time. You must reboot to use the new fi rmware.

5. Click Close to exit the Upgrade Firmware window.
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CAUTION: Do not turn off the AutoView 1000R/2000R while it is rebooting.

To simultaneously upgrade multiple AVRIQ adaptors:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Upgrade AVRIQ Firmware button. The Upgrade AVRIQ 
Firmware dialog box appears. 

3. Click the checkboxes in front of each type of AVRIQ adaptor to upgrade.

4. Click Upgrade. The Upgrade button dims. The Status column will display 
either In Progress or Succeeded, depending on the status of each AVRIQ 
upgrade. A Firmware upgrade currently in progress message displays until 
all of the selected AVRIQ adaptor types are upgraded.

5. When complete, a message appears prompting you to confi rm the upgrade 
completion. Once confi rmed, the Upgrade button is again enabled. 

6. Click Close to exit the Upgrade Firmware window.

To upgrade AVRIQ fi rmware individually:

1. Click the Settings tab in the AMP. 

2. Click the AVRIQ sub-category under Versions in the left column in the AMP.

3. Select the EID pulldown menu and choose the AVRIQ adaptor for which 
you would like to view fi rmware information. The IDs displayed in the 
pulldown are a combination of the EID and either the server name or 
switch name, depending on what is attached to the AVRIQ adaptor. If the 
AVRIQ is not attached to anything, the pulldown will display None. Once 
selected, the fi rmware information appears in the Information box.

4. Compare it to the Firmware Available box to see the fi rmware upgrade 
available to the AVRIQ adaptor. If the AVRIQ adaptor requires upgrading, 
click the Load Firmware button.

5. The fi rmware upgrade begins. During the upgrade, a progress message is 
displayed below the Firmware Available box and the Load Firmware 
button will dim. When the upgrade is fi nished, a message appears 
indicating that the upgrade was successful. 

6. Repeat steps 2-5 for each AVRIQ to upgrade. 

7. When fi nished, click OK.

Managing User Sessions
You may view and disconnect the current active user connections using the Status 
tab in the AMP. You can view the length of time the users have been connected, the 
server name or AVRIQ to which they are connected and their system address.
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Figure 4.11: User Status Dialog Box

To disconnect a user session:

1. Click the Status tab in the AMP. The User Status dialog box appears. 

2. Click one or more users to disconnect.

3. Click the Disconnect Session button. A message appears prompting you to 
confi rm the disconnect command. 

4. Click Yes to disconnect the user.
-or-
Click No to exit without completing the disconnect command.

Rebooting Your Appliance
You can reboot the AutoView 1000R/2000R through the Tools tab in the AMP. 
When clicked, Reboot will broadcast a disconnect message to any active users, 
then log out the current user and immediately reboot the appliance. 

To reboot your appliance:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Reboot button. A message prompting you to confi rm this reboot 
appears. Click Yes to confi rm the request. The appliance will now reboot.

Managing Appliance Configuration Databases
An on-board database contains all of the settings for an appliance. This includes 
network settings, AVRIQ configurations, SNMP settings and attached servers. 
You may save this configuration information to a client-based file and, should 
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you ever need to replace your AutoView 1000R/2000R, restore the configuration 
file to the new appliance and avoid manually configuring it.

NOTE: User account information is stored in the user database, not in the confi guration fi le. 
For more information, see Managing User Databases in this chapter.

To read and save a confi guration to a fi le from an appliance:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Save Appliance Confi guration button. The Save Appliance 
Confi guration dialog box appears. 

3. Click Browse and navigate to a location to save the Confi guration fi le. The 
location appears in the Save To fi eld.

4. Click Save. The confi guration fi le is read from the appliance and saved to 
the desired location. A progress window displays. 

5. When complete, a message appears prompting you to confi rm the read 
completion. Click OK to return to the main window.

To restore a confi guration fi le to an appliance:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Restore Appliance Confi guration button. The Restore Appliance 
Confi guration File dialog box appears. 

3. Click Browse and navigate to the location where you stored the saved 
confi guration fi le. The fi le name and location appears in the File name fi eld.

4. Click Restore. The confi guration fi le is written to the appliance. A progress 
window displays. 

5. When complete, a message appears prompting you to confi rm the write 
completion. Click OK to return to the main window.

Managing User Databases
An on-board user database contains all the user accounts and access rights 
assigned in an appliance. You can save this database to a client-based file and 
use it to configure users on other appliances by restoring the user account file 
to the new appliance.

NOTE: The user account fi le is encrypted and you will be prompted to create a password when 
you save the fi le. You will need to enter this password when you write the fi le to a new unit.

To save a user database from an appliance:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 
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2. Click the Save Appliance User Database button. The Save Appliance User 
Database dialog box appears. 

3. Click Browse and navigate to a location to save the user database fi le. The 
location appears in the Save To fi eld.

4. Click Save. The user database fi le is read from the appliance and saved to 
a location. A progress window displays. 

5. When complete, a message appears prompting you to confi rm the read 
completion. Once confi rmed, the Save Appliance User Database dialog box 
will close and you are returned to the Tools window.

To restore a user database fi le to an appliance:

1. Click the Tools tab in the AMP. The Tools dialog box appears. 

2. Click the Restore Appliance User Database button. The Restore Appliance 
User Database dialog box appears. 

3. Click Browse and navigate to the location where you stored the saved user 
database fi le. The fi le name and location appears in the File name fi eld.

4. Click Restore. The user database fi le is written to the appliance. A progress 
window displays. 

5. When complete, a message appears prompting you to confi rm the write 
completion. Once confi rmed, the Restore Appliance User Database dialog 
box will close and you are returned to the Tools window.

Changing Appliance Properties
You can alter individual appliance properties whether you are logged into the 
switch or not. The Properties dialog box contains several tabs: General, Network 
and Information. The General tab allows you not only to change the name and 
display icon for an appliance but also to assign the switch to a site, location or 
department. The Network tab allows you to establish an IP address for that switch. 
The Information tab allows you to enter information about the appliance including 
a description, contact information and any comments you would like to add. 

To change appliance properties:

1. Select an individual appliance in the Unit Selector list.

2. Select View - Properties from the AVWorks Explorer menu bar.
-or-
Click the Properties button. 
-or-
Right-click on the switch and select Properties from the pop-up list. The 
Properties dialog box appears.
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Figure 4.12: Appliance General Properties

3. Type in the name of the appliance. A warning will display if you enter a 
duplicate name. 

4. Skip the Type fi eld. This is read-only for appliances. 

5. Select the icon to display for the unit.

6. (Optional) Select the site, department and location to which you would like 
the appliance assigned. If a selection is not in the pulldown, type the name 
of the new assignment in the text fi eld. Once entered, the option becomes 
available in the pulldown for future assignment.

7. Click the Network tab and type in the address of the appliance. This fi eld can 
contain an IP dot notation or a domain name. Duplicate addresses are not 
allowed and the fi eld cannot be left blank. You can enter up to 128 characters. 

8. (Optional) Click the Information tab and type in the description of the 
unit. You are free to enter any information into these fi elds.

9. When fi nished, click OK to save the new settings.
-or-
Click Cancel to exit without saving.

Changing DirectDraw® support
AVWorks supports DirectDraw, a standard that allows direct manipulation of 
video display memory, hardware blitting, hardware overlays and page flipping 
without the intervention of the Graphical Device Interface (GDI). This can 
result in smoother animation and improvement in the performance of display-
intensive software. 
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However, if your machine has a software cursor or pointer shadow enabled, or 
if your video driver does not support DirectDraw, you may experience a flicker 
in your mouse cursor when over the title bar of the Viewer. 

You can either disable the software cursor or pointer shadow, or load a new 
driver for your video card. Or you can disable DirectDraw.

Figure 4.13: Options Dialog Box - DirectDraw

To disable DirectDraw:

1.  Select Tools-Options. The Options dialog box appears.

2. Deselect the DirectDraw checkbox. 

3. Click OK.

Adding and Deleting Product Licenses
AVWorks is designed to work with a variety of appliances. To support this 
growing number of appliances, AVWorks allows you to add new product 
licenses as they become available. AVWorks ships with the AutoView 1000R/
2000R product license already enabled. However, you may wish to add 
additional product licenses as your system grows. 

Product licenses are made up of a Product Code and a Product Key. The 
Product Code and Product Key are provided by Avocent. The Discover Wizard 
and the New Appliance Wizard only support the discovery and installation of 
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enabled products. New product licenses can be added and existing licenses can 
be deleted from this dialog as well.

To view licenses:

Select Tools - License Manager. The License Manager dialog box appears.

To add a license:

1. Select Tools - License Manager. The License Manager dialog box appears.

2. Click the Add button. The Add License dialog box appears.

3. Enter the Product Code and Key that you received from Avocent.

4. Click OK to save the new product license.
-or-
Click Cancel to exit without saving changes.

To delete a license:

1. Select Tools - License Manager. The License Manager dialog box appears.

2. Select a product from the Licensed Product list. 

3. Click the Delete button. A warning message appears to prompt you to 
confi rm the deletion. Click OK to delete the product license.
-or-
Click Cancel to exit the delete operation without deleting the product license.
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Appendices
Appendix A: Updating AVWorks
For optimal performance, ensure that you have the latest version of AVWorks 
available from the Avocent web site.

To update AVWorks:

1. Download the update fi le from http://www.avocent.com/support.

2. Double-click on the installer. The installer will check to see if a previous 
version of AVWorks resides on your system. 

3. If no previous version has been detected and a dialog box appears to 
confi rm the upgrade, click Continue.
-or-
If a previous version is detected and a dialog box appears alerting you to 
another version of the product, click Overwrite to confi rm the upgrade.
-or-
Click Cancel to exit without upgrading the software.

4. Installation begins. The Program Files, Shortcuts, Environment Variables, 
and the Registry Entries (on Windows 32 systems), will be installed or will 
be overwritten with the new fi les and settings of the current version.

NOTE: In order for the upgrade detection process to work, you must fi rst either reboot or log 
out. Environment Variables set by the installer are not permanent on Windows 32 platforms or 
Linux until you have logged out or rebooted the system.
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Appendix B: Keyboard and Mouse Shortcuts

Divider Pane Keyboard and Mouse Shortcuts

Operation Description

F6 Navigates between the split-screens and gives focus to the last element 
that had focus.

F8 Gives focus to the divider.

Left or Up Arrow Moves the divider left if the divider has the focus.

Right or Down Arrow Moves the divider right if the divider has the focus.

Home Gives the right pane of the split-screen all of the area (left pane 
disappears) if the divider has the focus.

End Gives the left pane of the split-screen all of the area (right pane 
disappears) if the divider has the focus.

Click + Mouse Drag Moves the divider left or right.

Tree View Control Keyboard and Mouse Shortcuts

Operation Description

Mouse Single-Click Deselects the existing selection and selects the node the mouse pointer 
is over.

Mouse Double-Click Toggles the expand/collapse state of an expandable node (a node that 
has children). Does nothing on a leaf node (a node with no children).

Up Arrow Deselects the existing selection and selects the next node above the 
current focus point. 

Down Arrow Deselects the existing selection and selects the next node below the 
current focus point. 

Spacebar Alternately selects/deselects the node that currently has the focus.

Enter Alternately collapses/expands the node that has focus. Only applies to 
nodes that have children. Does nothing if a node has no children.

Home Deselects the existing selection and selects the root node.

End Deselects the existing selection and selects the last node displayed in 
the tree.

Keyboard and Mouse Operations for the Unit List

Operation Description

Enter or Return Launches the default action for the selected unit. 

Up Arrow Deselects current selection and moves selection up one row.

Down Arrow Deselects current selection and moves selection down one row.

Page Up Deselects current selection and scrolls up one page, then selects the 
fi rst item on the page.
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Operation Description

Page Down Deselects current selection and scrolls down one page, then selects 
the last item on the page.

Delete Performs the Delete function. Works the same as the Edit>Delete 
menu function.

Ctrl + Home Moves the focus and the selection to the fi rst row in the table.

Ctrl + End Moves the focus and the selection to the last row in the table.

Shift + Up Arrow Extends selection up one row.

Shift + Down Arrow Extends selection down one row.

Shift + Page Up Extends selection up one page. 

Shift + Page Down Extends selection down one page.

Shift + Mouse Click Deselects any existing selection and selects the range of rows between 
the current focus point and the row the mouse pointer is over when 
the mouse is clicked. 

Ctrl + Mouse Click Toggles the selection state of the row the mouse pointer is over without 
affecting the selection state of any other row.

Mouse Double-Click Launches the default action for the selected unit.

Download from Www.Somanuals.com. All Manuals Search And Download.



68 AVWorks Installer/User Guide

Appendix C: TCP Ports
The Video Session Viewer communicates with the AV1000R/2000R over TCP 
ports 8192 and 2068. Digitized video data is sent over port 8192. Encrypted 
keyboard and mouse data is sent over port 2068. The Appliance Management 
Panel (AMP) communications with the AV1000R/2000R over TCP port 3211. 
All data on ports 2068 and 3211 is encrypted using the Secure Socket layer 
(SSL) protocol.

The AV1000R/2000R retains the database of user accounts and permissions. 
The Video Session Viewer performs user authentication over encrypted port 
2068. The AMP performs user authentication over encrypted port 3211.

A1000R

Digital User

AVWorks

TCP/IP
Ports 8192, 3211

and 2068

Figure C.1: TCP Port Communication
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Appendix D: Troubleshooting
Adjusting the video quality

The Video Viewer offers both automatic and manual video adjustment capability. 
Generally, the Automatic Video Adjustment will optimize the video for the best 
possible view. However, you may fine tune the video with the aid of Avocent 
technical support. 

Manual Video Adjust Dialog Box Options

A

I

B C D E F G H

J
K

L

M

N

O

Figure D.1: Manual Video Adjust Dialog Box

A. Image Capture Width I. Automatic Video Adjustment

B. Image Capture Height J. Refresh Image

C. Image Capture Horizontal Position K. Adjustment bar 

D. Image Capture Vertical Position L. Video Test Pattern

E. Contrast M. Help button

F. Brightness N. Performance Monitor

G. Noise Threshold O. Close box

H. Priority Threshold 

To manually adjust the video quality of the Video Viewer window:

1. Select Tools - Manual Video Adjust. The Manual Video Adjust dialog 
box appears.

2. Click the icon for a feature to adjust. 

3. Move the slider bar and then fi ne tune the setting by clicking the Minus (-) 
or Plus (+) buttons to adjust the parameter for each icon pressed. The 
adjustments will display immediately in the Video Viewer window.

4. When fi nished, click Close to exit the Manual Video Adjust dialog box.
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Appendix E: Technical Support
Our Technical Support staff is ready to assist you with any installation or 
operating issues you encounter with your Avocent product. If an issue should 
develop, follow the steps below for the fastest possible service:

1. Check the pertinent section of this manual to see if the issue can be 
resolved by following the procedures outlined.

2. Check our web site at www.avocent.com/support to search the knowledge 
base or use the on-line service request.

3. Call Avocent Technical Support for assistance at (888) 793-8763. Visit the 
Avocent web site at http://www.avocent.com/support and click on Getting 
Support for current phone support hours.
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LIMITED WARRANTY 

Avocent Corporation warrants to the original retail purchaser that this product is and will be free from defects 
in materials and workmanship for a period of 24 months from the date of purchase.
 
Additionally, all Avocent products carry an unconditional thirty-day satisfaction guarantee. If, for any reason, you 
are dissatisfi ed with the performance of this product, you may return it to the point of purchase for a refund of 
the purchase price (excluding shipping charges). This guarantee does not apply to special order products, and 
may not be available through all resellers. During the warranty period, purchaser must promptly call Avocent 
for a RETURN MATERIALS AUTHORIZATION (RMA) number. Make sure that the RMA number appears on the 
packing slip, proof of purchase, AND ON THE OUTSIDE OF EACH SHIPPING CARTON. Unauthorized returns 
or collect shipments will be refused.

Ship prepaid to:                      Avocent Corporation 
                                                 4991 Corporate Drive
                                                 Huntsville, AL 35805 U.S.A. 
                                                 Telephone: (256) 430-4000 
 
The above limited warranty is voided by occurrence of any of the following events, upon which the product is 
provided as is, with all faults, and with all disclaimers of warranty identifi ed below:

1.    If non-Avocent approved cabling is attached to the unit. Poorly constructed and miswired cabling can diminish 
video quality and damage equipment. Avocent manufactured cabling is built to high quality standards utilizing 
overall braided shield to comply with FCC emission standards, and each cable is individually tested under 
load.

2.    If defect or malfunction was caused by abuse, mishandling, unauthorized repair, or use other than 
intended. 

3.    If unauthorized modifi cations were made to product. 
4.    If unreported damages occurred in any shipment of the product. 
5.    If damages were due to or caused by equipment or software not provided by Avocent.
6.    If the unit is used with non-grounded or incorrectly polarized AC power.
7.     If the product is used in contradiction to any instruction provided by any User Guide or Instruction Sheet 

provided to you or with the product.
8.    If the product is damaged due to power surges, water exposure or act of God including lightning.

EXCEPT AS SPECIFICALLY PROVIDED ABOVE AND TO THE MAXIMUM EXTENT ALLOWED BY LAW, 
AVOCENT CORPORATION DISCLAIMS ALL WARRANTIES AND CONDITIONS WHETHER EXPRESS, 
IMPLIED, OR STATUTORY AS TO ANY MATTER WHATSOEVER INCLUDING, WITHOUT LIMITATION, 
TITLE, NON-INFRINGEMENT, CONDITION, MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR OR 
INTENDED PURPOSE.

EXCEPT AS EXPRESSLY PROVIDED ABOVE AND TO THE MAXIMUM EXTENT ALLOWED BY LAW, AVOCENT 
CORPORATION SHALL NOT BE LIABLE FOR ANY SPECIAL, INDIRECT OR CONSEQUENTIAL DAMAGES 
(INCLUDING WITHOUT LIMITATION, LOSS OF PROFIT, LOSS OF BUSINESS, LOSS OF INFORMATION, 
FINANCIAL LOSS, PERSONAL INJURY, LOSS OF PRIVACY OR NEGLIGENCE) WHICH MAY BE CAUSED BY OR 
RELATED TO, DIRECTLY OR INDIRECTLY, THE USE OF A PRODUCT OR SERVICE, THE INABILITY TO USE A 
PRODUCT OR SERVICE, INADEQUACY OF A PRODUCT OR SERVICE FOR ANY PURPOSE OR USE THEREOF 
OR BY ANY DEFECT OR DEFICIENCY THEREIN EVEN IF AVOCENT CORPORATION OR AN AUTHORIZED 
AVOCENT DEALER HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES OR LOSSES.

©2002 Avocent Corporation. All rights reserved.
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590-257-001A 

For Technical Support:

Avocent Corporation
4991 Corporate Drive
Huntsville, Alabama 35805-6201 USA
Tel: +1 256 430 4000 
Fax: +1 256 430 4031

Avocent International Ltd.
Avocent House, Shannon Free Zone
Shannon, County Clare, Ireland
Tel: +353 61 715 292
Fax: +353 61 471 871

Avocent Asia Pacifi c
Singapore Branch Offi ce
100 Tras Street, #15-01
Amara Corporate Tower
Singapore 079027 
Tel: +656 227 3773
Fax: +656 223 9155

Avocent Germany
Gottlieb-Daimler-Straße 2-4
D-33803 Steinhagen
Germany
Tel: +49 5204 9134 0
Fax: +49 5204 9134 99

Avocent Canada
50 Mural Street, Unit 5
Richmond Hill, Ontario
L4B 1E4 Canada
Tel: +1 877 992 9239 
Fax: +1 877 524 2985

Email: support@avocent.com
www.avocent.com

Download from Www.Somanuals.com. All Manuals Search And Download.



Free Manuals Download Website
h�p://myh66.com

h�p://usermanuals.us
h�p://www.somanuals.com

h�p://www.4manuals.cc
h�p://www.manual-lib.com
h�p://www.404manual.com
h�p://www.luxmanual.com

h�p://aubethermostatmanual.com
Golf course search by state

h�p://golfingnear.com
Email search by domain

h�p://emailbydomain.com
Auto manuals search

h�p://auto.somanuals.com
TV manuals search

h�p://tv.somanuals.com

http://myh66.com/
http://usermanuals.us/
http://www.somanuals.com/
http://www.4manuals.cc/
http://www.manual-lib.com/
http://www.404manual.com/
http://www.luxmanual.com/
http://aubethermostatmanual.com/
http://www.golfingnear.com/
http://emailbydomain.com/
http://auto.somanuals.com/
http://tv.somanuals.com/

